
WHY IS THE PROVIDER ATTESTATION FORM NEEDED 

The South Carolina Department of Health and Human Services (SCDHHS) will implement 42 CFR Part 438, 441, 
and 447, Increased Medicaid Payments for Primary Care. This action implements the Affordable Care Act 
(ACA) requirement that increases payments to physicians with a specialty designation of family medicine, 
general internal medicine, pediatric medicine, and related subspecialists for specified primary care services 
and charges for vaccine administration under the Vaccines for Children Program. 

To qualify for the enhanced rates, a physician must self-attest to his or her specialty designation of family 
medicine, general internal medicine, pediatric medicine or a subspecialty recognized by the American Board of 
Medical Specialties (ABMS), the American Board of Physician Specialties (ABPS) or the American Osteopathic 
Association (AOA). Any of these physicians with one of the specialty designations must meet one of the 
following criteria:  

 Board certification and/or  

  Sixty (60) percent of all Medicaid services billed, or provided in a managed care environment in CY 
2012 are for E&M codes 99201-99499 and vaccine administration codes 90460, 90461, 90471, 90472, 
90473 and 90474. 

The provision provides for increased payments for primary care services furnished by a nurse practitioner or a 
physician assistant under the personal supervision of a physician who is one of the primary care specialties or 
subspecialty types designated in the regulation. Physicians will be required to attest for the nurse practitioners 
and/or physician assistants under his/her supervision who would qualify for the increased payments. All 
providers, both providers participating with Medicaid FFS and those only participating with MCOs will need to 
register with SCDHHS and then complete the Primary Care Provider Attestation form to become eligible to 
receive the enhanced primary care reimbursement rates.  

 

WHAT SHOULD I DO IF I HAVE ADDITONAL QUESTIONS OR ISSUES 

You may contact the Provider Service Center (PSC) by calling 1-888-289-0709. The hours of operation are 
Monday-Friday from 7:30am to 5:00pm.  Additionally you may submit your question or issue through the 
agency website at http://www.scdhhs.gov/webform/contact-provider-representative.   
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WHO SHOULD COMPLETE THE PROVIDER ATTESTATION FORM 

 South Carolina Medicaid providers currently enrolled or enrolling as a Family Practice, General Internal 
Medicine, or Pediatric provider who provide and and request reimbursement for the following 
procedure codes under their NPI: 
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 Nurse Practitioners and Physician Assistants who provide the above referenced services under the 
supervision of an enrolled or enrolling Family Practice, General Internal Medicine, or Pediatric South 
Carolina Medicaid provider and who request reimbursement for these services. 
 

ACCESSING THE PROVIDER ATTESTATION WEB PAGE 

Existing Providers:  Providers currently enrolled with South Carolina Medicaid as a Family Practice, General 
Internal Medicine, or Pediatrics provider will access the Provider Attestation Form from the South 
Carolina Department of Health and Human Services (SCDHHS) Affordable Care Act (ACA) web page.   
The attestation Form hyperlink, https://msp.scdhhs.gov/pc/,will open a new internet browser window 
in which the Provider will enter and submit the required attestation information. 

New Enrollment Providers:  Providers who are completing a new Family Practice, General Internal 
Medicine, or Pediatric provider enrollment application via the online Provider Enrollment Web 
Application will be prompted to complete the attestation form when completing the Provider Type and 
Specialty/Subspecialty page of the application.  Selecting the attestation hyperlink will open a new 
internet browser window in which the Provider will enter and submit the required attestation 
information.  As this is a separate internet browser window, the Provider may complete this form 
during or after the completion of the Provider Enrollment web application.   

  

https://msp.scdhhs.gov/pc/
https://msp.scdhhs.gov/pc/
https://providerservices.uat.scdhhs.gov/ProviderEnrollmentWeb/backPERestore.action
https://providerservices.uat.scdhhs.gov/ProviderEnrollmentWeb/backPERestore.action


 

CREATING A PROVIDER ATTESTATION NEW ACCOUNT/USER LOGIN 

1. Select the Affordable Care Act Initiatives article in the Resources column in the SCDHHS Provider 
home page (https://www.scdhhs.gov/).  

 

  

https://www.scdhhs.gov/


2. Access the attestation form from the embedded Form link found in the Primary Care Physician 
Attestation section of this web article. 

 

  



3. The Create new account / User Login page will display when the link is selected. 

 
 
4. Select the Create new account tab from the defaulted Create new account / User Login page. 

 

 

 



 

5. The User account page will be displayed.  

 
 
6. Enter the name you would like associated with this record in the Username text box. (Required)             

i e:  RobertSmith13 
7. Enter the email address you would like associated with this record in the E-mail Address text box. 

(Required) i e:  RSmithMDXXX@yahoo.com  
8. Enter the password you would like associated with this record in the Password text box. (Required) 

a. Passwords must be at least ten (10) alphanumeric characters in length 
b. Password must contain at least one (1) uppercase character 
c. Password must contain at least one (1) punctuation character 
d. A correct password example:  CanDoIn13! 

9. Re-enter the same password from Step 4 in the Confirm password text box.  (Required) 
10. Enter the solution to the CAPTCHA Math Question in the text box. (Required) 

i e:    Math question: * 4 + 9 = 
13

 
11. Select Create new account 
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COMPLETING THE PROVIDER ATTESTATION FORM 
12. The Attestation Form page will appear after successfully creating your user account. 

 

13. Enter the enrolled or enrolling Provider’s name as is registered with the South Carolina Medicaid 
program in the Individual Provider Name text box. (Required) 

  



 
14. Select the appropriate Provider type (Family Medicine, General Internal Medicine, or Pediatric 

Medicine) from the available Are you a physician with a specialty designation of? : checkboxes.   

 
 
15. Select the appropriate Select Subspecialty drop down arrow ( ) next to the applicable Board 

Certification type.  

 

 

 

 

 

 

 

  



 
16. Determine the appropriate Board Specialty type (Family Medicine, Internal Medicine, Pediatric, or 

Physician Specialties) for the selected Board Certification.  Note:  The “Physician Specialty” is only 
applicable to the American Board of Physician Specialties board certification type.    Both the 
American Board of Medical Specialties and the American Osteopathic Association board 
certification types have subspecialty selections in the Family Medicine, Internal Medicine, and 
Pediatric categories. (Required) 

 

  



 
17. Select the appropriate subspecialty type from the drop down list of applicable subspecialties. 

 
 
18. Enter the Provider’s ten (10) digit individual National Provider Identifier (NPI) assigned by the 

National Plan and Provider Enumeration System (NPPES) in the Individual NPI text box.  Note:  
When completing an attestation form for an Advanced Practice Registered Nurse’s (APRN) or the 
Physician Assistant’s (PA), enter their individual NPI. (Required) i e: 1234567893 

19. Re-enter the same ten (10) digit individual NPI in the Individual NPI Again text box. (Required) 
20. Enter the Provider’s billing NPI in the Billing NPI text box (Required).  
21. Enter the Provider’s physical location street address information in the Address text box.          

Note:  P.O. Box addresses are not considered valid location addresses.   
22. Enter the Provider’s physical location city information in City text box. 
23. Select the Provider’s physical location State information from the State selection list. 
24. Enter the Provider’s contact telephone number in the Telephone text box including the 

parentheses around the area code and a dash between the first three (3) and last four (4) digits.                                    
i e: (888) 289-0709 

25. Enter the Provider’s fax number in the Fax text box including the parentheses around the area code 
and a dash between the first three (3) and last four (4) digits.  i e: (888) 289-0709 

26. Enter an additional Provider contact email address in the Email text box if this email address differs 
from the one entered by the Provider when creating the user account in Step 4. 

  



 
27. Select either of the “Yes” radio buttons selections as the answer to the Are You Board Certified? : 

question in Section II:  Attestation Statement.  Note:  In order to qualify for the increased 
payments, the provider must be either at least board certified or 60% of the billed Medicaid 
services, or provided in a managed care environment , must be for the procedure codes listed above 
in the WHO SHOULD COMPLETE THE ATTESTATION FORM section of this document.  (A Selection is 
Required)  

 

 

28. Select the No checkbox next to the verification response to the For Supervisor of Advanced 
Practice Registered Nurse and Physician Assistant statement if the enrolling Provider does not 
supervise any APRNs or PAs.   

 

  



 

29. Enter the legal name for the Advanced Practice Registered Nurse (APRN) or Physician Assistant (PA) 
in the 1st NP or PA Name text box. 

 

30. Enter the NPI for the Advanced Practice Registered Nurse (APRN) or Physician Assistant (PA) 
entered in the 1st NP or PA Name text box. 

 

31. Enter the legal name and the NPI for up to two additions APRNs or PAs, if applicable. 
32. Read the attestation certification statement. 

 

  



 

33. Select either Submit to save the entered information or Save Draft when all of the information is 
not entered and you must secure this information before submitting a complete attestation form.        
Note:  As a reminder, the information cannot be changed by the Provider once the attestation form 
has been submitted.  Any needed changes will require the Provider to contact the Provider Service 
Center by calling (888) 289-0709. 

 

 

34. View the Attestation Form submission notification.   

 

 

 

 

 



35. Select Log out from the action menu to close the record. (Required) 

 

 

36. Close the internet browser window by either selecting “Exit” form the File menu selection list or by 

selecting the internet browser window exit icon .  

 

  



 

 

COMPLETING A “SAVED DRAFT” ATTESTATION FORM 

37. Select the Affordable Care Act Initiatives article in the Resources column in the SCDHHS Provider 
home page (https://www.scdhhs.gov/).  

 

  

https://www.scdhhs.gov/


38. Access the attestation form from the embedded Form link found in the Primary Care Physician 
Attestation section of this web article. 

 

  



 
39. The Create new account / User Login page will display when the link is selected. 

 

40. Enter the Username created in Step 6 in the Username text box. 
41. Enter the Password created in Step 8 in the Password text box.  
42. Select Log in. 

  



 
43. The Attestation Form web page will display and the previously entered information will be 

populated. 

 

44. Enter the information needed to complete the attestation form.   
45. Complete Steps 34 – 35 to submit the attestation form and close the internet browser window.   

 

  



REVIEWING A SUBMITTED PROVIDER ATTESTATION FORM 

46. Complete Steps 36 – 41 to access the attestation form. 
47. Select Recent posts from the attestation form action menu.  

 

 

48. Select the Attestation Form from the Recent posts page. 

 

  



 

49. Select View your previous submissions from the Attestation Form web page. 

 

  



 

 

50. Select the appropriate View to be reviewed from the available Submissions for [Username] web 
page. 

 
 
51. Review your previous Provider Attestation Form submission. 
52. Complete Steps 34 and 35 to end the submission review and close the web browser.  

 

CHANGING YOUR PASSWORD, USERNAME, EMAIL ADDRESS 

53. Complete Steps 36 - 41 to access the Attestation Form web page. 
54. Select My account from the Action Menu. 

 

  



 

55. Select the Edit tab from the user Home Page. 

 
 

56. Enter the new Username, Email Address, Password, and/or the Time Zone you would like to be 
associated with your submitted attestation form in the appropriate text boxes, or for Time Zone 
the selection box, in the Edit tab of the My Account page.  Your Username and Email address will 
default the current values.  Enter ONLY the information being changed in these text boxes.  For 
example, it is not necessary to change your Username if you are only changing your password.     
 Note:  The same new password must be entered in the Password and the Confirm Password text 
boxes and must match exactly in order to save the change of password.  

 



 
57. Select Save. 
58. Complete Steps 34 and 35 to close the internet browser window.  

 

 

FORGOT YOUR PASSWORD 

59. Complete Steps 36 - 41 to access the Attestation Form web page or if you are working within the 
attestation form, return to the Home page by selecting Home> in the navigation links.   

 

60. Select the Request new password tab from the User Account page. 

 



61. Enter either your registered email address or your Username in the Username or email address 
text box.  

 
 
62. Select E-mail new password. 
63. Check your registered email address for receipt of an email containing the link to create a new 

password.   
64. Click on the inserted link within the email. 

 

 



65. Select the Log in button in the Reset Password page. 

 

 

66. Enter your new password exactly the same in the Password and the Confirm password text boxes.  

 

  



 

67. Select Save to update the password information. 
68. Continue with the attestation form actions as needed. 

 

IMPORTANT FACTS 
 Upon submitting the attestation form, the information cannot be changed by the provider.  Should 

changes to the submitted data be required, the provider will need to contact the Provider Service 
Center by calling (888) 289-0709.  

 You can register only one Username to an email address BUT you can create multiple attestation forms 
for multiple providers under this username/email association.   
 

 


